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Introduction 

This document contains step-by-step description of the hardware and software installation, 

configuration and calibration to prepare ERP recording system. 

 

IMPORTANT! The configuration on new ERP systems differs from previous one. 

Therefore, installation procedures, configuration and calibration are slightly different from 

those described in “WinEEG” User Manual and “PSYTASK” User Manual. 

 

ERP recording system components 

The system configuration is shown in Fig. 1. This system consists of several components that are 

listed in Table 1. 

 

 
Fig. 1. Configuration of the ERP recording system. 

 
“1” -  Monitor of “Master” computer; “2” - Monitor cable of “Master” computer; “3” - 

Software USB dongle (Guardant dongle); “4” - CPU of “Master” computer; “5” - 

Ethernet cable (Network cable or Patch cord); “6” - USB A cable– mini USB B; “7” - EP 

sensors; “8” - Patient button; “9” - Mitsar-EEG Amplifier box; “10” – Loudspeakers; 

“11” - Cable for speakers; “12 - Monitor of “Slave” computer; “13” - CPU of “Slave” 

computer; “14” - Monitor cable of “Slave” computer; “15” – Video sensor. 
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Table 1. List of main components for the ERP recording system 

# Component Digital 

mark(s) 

in Fig. 1 

Main functions 

1. Mitsar-EEG amplifiers 

box: 

“Mitsar-EEG-201” or 

“Mitsar-EEG-202” 

“9” 

1. EEG signal amplification, analog-digital 

conversion and transmission of data to the computer. 

2. Detection of the synchronization signals from the 

video sensor and audio splitter and transmission 

them to the computer 

2. “Master” computer* 

with WinEEG software 

 

(IBM PC compatible, 

Windows Vista, 7, 8, 

10). 

“1”,  

“2”,  

“4” 

1. Collection of data from the amplifiers box. 

2. Recording external events: stimulus marks, and 

subject response. 

3. Storing the data on a hard disk.  

4. Processing and visualization of the data. 

5. Control of the "Slave” computers. 

3. “Slave” computer* 

with PSYTASK 

software 

 

(IBM PC compatible, 

Windows Vista, 7, 8, 

10). 

“12”, 

“13”, 

“14” 

1. Presentation (generation) of visual and auditory 

stimulus. 

2. Generation of the video synchronization signals. 

Auditory stimulus itself may be used as a 

synchronization signal. Therefore, an additional 

synchronization signal is not required to auditory 

stimuli.  

4. Loudspeakers 
“10” 

Reproduction of sounds generated by “Slave” 

computer. 

6. Video sensor “15” Detection of video synchronization signals. 

7. Patient button “8” Detection of subject response. 

8. Guardant dongle 
“3” 

This device protects the WinEEG software from 

unauthorized copying. 

* Recommended configuration of computers can be found on the web sites: 

http://www.mitsar-medical.com or http://www.mitsar-eeg.ru 

http://www.mitsar-medical.com/
http://www.mitsar-eeg.ru/
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Hardware installation 

Several components of the ERP recording system must be correctly connected during its 

installation. Safe way to connect the ERP recording system components is as follows. 

 

1. Turn off the “Master” and “Slave” computers. 

 

2. Disconnect the “Master” and “Slave” computers from the Power socket. 

 

3. Turn off the Loudspeakers. 

 

4. Disconnect the Loudspeakers from the Power socket. 

 

5. Connect the Mitsar-EEG amplifiers box to the “Master” computer using USB cable. 

 

6. Connect together the “Master” and “Slave” computers using Network cable (Patch cord). 

(We strongly recommend to use the direct connection of two computers, instead of 

connecting them to a computer network. The direct connection will provide the best 

performance of the ERP recording system.) 

 

7. Connect the Loudspeakers to the first output of sound card of the “Slave” computers. 

 

8. Connect the "EP sensors" to the appropriate input of the Mitsar-EEG amplifiers box. 

 

9. Place and fix the "Video sensor" near the left border of the monitor screen. (The most 

appropriate vertical position of the "Video sensor" is the center of the screen. Such 

vertical position of the "Video sensor" is appropriate for most of ERP research. But 

perhaps another position is required in a number of other cases.) 

 

10. Connect the additional cable of the "EP sensors" to the second output of of sound card of 

the “Slave” computers. 

 

11. Connect the Patient button to appropriate input of the Mitsar-EEG amplifiers box. 

 

12. Connect the Guardant dongle to USB port of the “Master” computer. 

 

13. Connect the “Master” and “Slave” computers to the Power socket. 

 

14. Connect the Loudspeakers to the Power socket. 

 

15. Turn on the “Master” and “Slave” computers. 

 

16. Turn on the Loudspeakers. 
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Software installation 

You must install the following software components to the ERP recording system. 

 

“Master” computer: 

 

1. WinEEG software. (It can be download from web sites http://www.mitsar-medical.com 

or http://www.mitsar-eeg.ru) 

 

2. Mitsar-EEG amplifiers box driver. (It can be download from web sites 

http://www.mitsar-medical.com, or http://www.mitsar-eeg.ru, or 

http://www.ftdichip.com/) 

 

3. Guardant dongle driver. (It can be download from web sites http://www.mitsar-

medical.com, or http://www.mitsar-eeg.ru, or http://www.guardant.com/) 

 

“Slave” computer: 

 

1. PSYTASK software. (It can be download from web sites http://www.mitsar-medical.com 

or http://www.mitsar-eeg.ru) 

 

2. DirectX 9 or later if it is not already installed. (It can be downloaded from Microsoft web 

site). 

 

The installation of these software components is described below. We strongly recommend that 

you reboot (restart) both the “Master” and “Slave” computer after installation the software 

components. 

http://www.mitsar-medical.com/
http://www.mitsar-eeg.ru/
http://www.mitsar-medical.com/
http://www.mitsar-eeg.ru/
http://www.ftdichip.com/
http://www.mitsar-medical.com/
http://www.mitsar-medical.com/
http://www.mitsar-eeg.ru/
http://www.guardant.com/
http://www.mitsar-medical.com/
http://www.mitsar-eeg.ru/
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WinEEG software installation. 
 

1. Insert the CD or USB memory stick to the corresponding drive of the “Master” computer. 

 

2. Open folder with name WinEEG. 

 

3. Run SETUP.EXE program. 

 

4. Follow the instruction on the screen. 

 

 
 

5. Press “Next” button to continue installation. 
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6. Press “Browse…” button if you would like to change location WinEEG program. Press 

“Next” button to continue installation. 

 

 
 

7. Select type of Setup you prefer. Press “Next” button to continue installation. If Custom 

installation is selected following window will appear on the screen: 
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8. Select components you want to install. Don’t install “Sounds” component if you don’t plan 

to use auditory biofeedback. 

 

 
 

9. Type a new folder name if you want. Press “Next” button to continue installation. 
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10. Press “Finish” button to complete Setup. 
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Mitsar-EEG amplifiers box driver. 
 

1. Insert the CD or USB memory stick to the corresponding drive of the “Master” computer. 

 

2. Open folder with name USBDRV. 

 

3. Run CDM21216Setup.EXE program. 

 

4. Follow the instruction on the screen. 

 

 
 

5. Press “Extract” button to continue installation. 
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6. Press “Next” button to continue installation. 

 

 
 

7. Read this agreement, select “I accept this agreement” button and press “Next” button to 

continue installation. 
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8. Press “Finish” button to complete Setup. 
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Guardant dongle driver. 
 

1. Insert the CD or USB memory stick to the corresponding drive of the “Master” computer. 

 

2. Open folder with name USB Dongle Guardant. 

 

3. Open folder with name ENG (or RUS). 

 

4. Run GrdDriverEX-x86.EXE program for Windows 32-bits version or GrdDriverEX-

x64.EXE program for Windows 64-bits version. 

 

5. Follow the instruction on the screen. 

 

 
 

6. Press “Next” button to continue installation. 
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7. Press “Next” button to continue installation. 

 

 
 

8. Press “Close” button to complete Setup. 
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PSYTASK software. 
 

1. Insert the CD or USB memory stick to the corresponding drive of the “Slave” computer. 

 

2. Open folder with name PSYTASK. 

 

3. Run SETUP.EXE program. 

 

4. Follow the instruction on the screen. 

 

 
 

5. Press “Next” button to continue installation. 
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6. Press “Browse…” button if you would like to change location of PSYTASK program. 

Press “Next” button to continue installation. 

 

 
 

7. Select the type of Setup you prefer and press “Next” button to continue installation. If 

Custom installation is selected following window will appear on the screen: 
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8. Select components you want to install. 

 

 
 

9. Type a new folder name if you want. Press “Next” button to continue installation. 
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10. Press “Next” button to complete Setup. 
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ERP recording system software configuration 

You must perform the configuration of the system after the hardware and software installation. 

The software configuration includes two steps: 

 

1. Computer network configuration 

 

2. WinEEG and PSYTASK software configuration. 

 

Network configuration 
 

Network configuration is performed about the same on both “Master” and “Slave” computers 

and includes following tree steps. 

 

1. Specifying the IP address of the computer. 

2. Definition of the working group for both computers. 

3. Verifying Network Settings 

 

In fact, the last two steps are not strictly necessary. But we strongly recommend that you perform 

these steps to make sure that the network is configured correctly and to simplify WinEEG and 

PSYTASK software configuration. 

 
1. Specifying the IP address of the computer. 

 

To specify an IP address of the computer, it is necessary to perform the following steps 

(Windows Vista specific) 

 

1. Move mouse pointer to the "Network" icon on desktop and click right button. The pop-up 

menu will appear on the screen. 

 

2. Select "Property" item. The "Network and Sharing Center" window will appear on the screen. 
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3. Select "Manage network connection" item. The "Network Connection" window will appear on 

the screen. 

 

 
 

4. Move mouse pointer to the "Network Connection" icon and double click left button. The 

"Network Connection Status" window will appear on the screen. 
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5. Press "Properties" button. The "Network Connection Properties" window will appear on the 

screen. 

 

 
 

6. Select "Internet Protocol Version 4 (TCP/IPv4)" option as it is shown above and press 

"Properties" button. The "Internet Protocol Version 4 (TCP/IPv4) Properties" window will 

appear on the screen. 
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7. Select "Use the following IP address:" option. 

 

8. Enter "IP address" into corresponding field. 

 

9. Enter "Subnet Mask" into corresponding field. 

 

10. Press "OK" button in the "Internet Protocol Version 4 (TCP/IPv4) Properties" window 

 

11. Press "Close" button in the "Network Connection Properties" window. 

 

12. Press "Close" button in the "Network Connection Status" window. 

 

13. Close the "Network Connection" window. 

 

14. Close the "Network and Sharing Center" window. 

 

IMPORTANT!!! The IP address and Subnet mask should be specified on both “Master” and 

“Slave” computers separately. Subnet mask should be identical on both computers. The subfields 

of IP addresses that correspond to non-zero subfields of Subnet mask should also be identical. 

But the subfields of IP addresses that correspond to the zero subfields of Subnet mask should not 

be identical. The following example illustrates these rules. 
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Example: 

 

Appropriate network settings may be the following: 

 

“Master” computer: 

 

IP address:  192.168.0.1 

Subnet mask: 255.255.255.0 

 

“Slave” computer: 

 

IP address:  192.168.0.2 

Subnet mask: 255.255.255.0 

 
2. Definition of the working group for both computers. 

 

1. Move mouse pointer to the "Computer" icon on desktop and click right button. The pop-up 

menu will appear on the screen. 

 

2. Select "Property" item. The "System" window will appear on the screen. 

 

 
 

3. Select "Change setting" item for the "Computer name, domain, and workgroup setting" . The 

"System Properties" window will appear on the screen. 
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4. Press "Change..." button. The "Computer Name/Domain Changes" window will appear on the 

screen. 

 

 
 

4. Enter "Computer name:" into corresponding field 
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5. Enter "Workgroup" into corresponding field 

 

6. Press "OK" 

 

7. Restart the computer. 

 

IMPORTANT!!!  The “Computer name:” and “Workgroup” should be specified on both 

“Master” and “Slave” computers separately. The “Workgroup” should be the same on both 

“Master” and “Slave” computers. The Computer names should be different. 

 

Example: 

 

“Master” computer: 

 

Computer name:  Valery 

Workgroup: PROGRAMM_ACTION 

 

“Slave” computer: 

 

Computer name:  Valery-PC 

Workgroup: PROGRAMM_ACTION 

 
3. Verifying Network Settings 

 

1. Move mouse pointer to the "Network" icon on desktop and double click left button. The 

"Network" window will appear on the screen. 

 

 
 

2. Wait until the search for computers on the network is over 
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3. Make sure that both computers are found in the network, as it is shown above 

 

4. Close "Network" window". 
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WinEEG and PSYTASK software configuration 
 

Important!!! Before you start to configure the WinEEG and PSYTASK software, make sure 

that the hardware software of ERP recording system is properly installed and the network 

settings are specified correctly. 

 

WinEEG and PSYTASK software configuration includes three steps: 

1. Specifying synchronization settings for PSYTASK software. 

2. Specifying equipment parameters and synchronization settings for WinEEG software. 

3. Testing the synchronization parameters for WinEEG and PSYTASK software. 

 
1. Specifying synchronization settings for PSYTASK software 

 

1. Start PSYTASK using shortcut on Desktop of  “Slave” computer. The main window of 

PSYTASK will appear on the screen. 

 

 
 

2. Press “Modify Synchronization Parameters” button. The “Parameters of Synchronization” 

window will appear on the screen. 
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3. Select “LAN” option in “Connection port for synchronization and its parameters” group as it 

is shown above. 

 

4. Make sure that “Synchronization mode” is selected as “Don’t send synchro codes (WinEEG 

control)” as it is shown above.. 

 

5. Make sure that all fields in “Correction of synchronization for” group are zeroed as it is shown 

above. 

 

6. Select appropriate parameters in the “Generation of synchronization signal for the screen” 

group. The recommended parameters are following (see Figure above): 

 

Position: “Left center” 

Size: “Very large” 

Type: Black on White. 

“For the first visual stimulus only” button is unchecked. 

 

7. Press “OK” button. 
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2. Specifying equipment parameters and synchronization settings for WinEEG software. 

 

1. Start WinEEG using shortcut on Desktop of “Master” computer. The main window of 

WinEEG will appear on the screen. 

 

2. Perform command “Setup->Equipment Parameters…” from main menu of WinEEG. The 

“Equipment configuration” window will appear on the screen. 

 

 
 

3. Select “Type of amplifies” as “Mitsar-EEG-201 or Mitsar-EEG-202”. 

 

4. Press “Find” button. If WinEEG have successfully found connected amplifiers box, their 

description will appear in the field with name “Amplifiers description” as it shown below. 
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5. Select “Sampling rate” as “500” (See above)  
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6. Make sure that Stimuli presentation system is selected as “PSYTASK”. 

 

7. Select “LAN” ” option in “Connection port for synchronization and its parameters as it is 

shown above. 

 

8. Enter into the “Name:” field the Network name of “Slave” computer.  

 

9. Press “Find” button from this group of fields and make sure that corrected IP address if 

“Slave” computer is displayed. 

 

10. Press “OK” button. 

 
3. Testing the synchronization parameters for WinEEG and PSYTASK software. 

 

1. Start PSYTASK using shortcut on Desktop of “Slave” computer if it is not already running. 

 

2. Press “Switch to Slave Mode” button in PSYTASK main window. 

 

Now, the PSYTASK is ready to work together with WinEEG.  

 

3. Start WinEEG using shortcut on Desktop of “Master” computer if it is not already running. 

 

4. Perform command “Setup->Stimuli Presentation Programs” from main menu of WinEEG. The 

“Stimuli presentation program list” window will appear on the screen. 

 

 
 

5. Press “Update” button. If the Network cable is connected and Network settings are correct the 

progress bar will display a process of transferring of task protocols from PSYTASK program to 

WinEEG program. Otherwise WinEEG program will report that the slave computer does not 

respond. You need to check the network connection and the network settings again and repeat 

the steps 1-5. 

 

6. Make sure that the list of stimuli presentation programs is correctly updated as it is shown 

below. 



 33 

 
 

7. Press “OK” button. 

 

Now, the WinEEG is ready to work together with PSYTASK. But the ERP recording system is 

not yet ready for ERP recording. This system should be calibrated (see below). 

 

Important!!!  It is necessary to perform steps 1-6 described in this section every time when the 

list of tasks or their parameters is changed in PSYTASK software. We recommend that you carry 

out this procedure each time before the ERP recording, if you are not sure that nobody has 

changed the list of tasks or their parameters. 

 

Important!!!  PSYTASK software is able to send correct task protocols (presentation program). 

Please be attentive and check newly added task protocols before updating list of presentation 

program for WinEEG software. Incorrect task protocols should be deleted from the list using 

PSYTASK software before updating. 
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ERP recording system calibration 

System calibration is performed to compensate for possible constant delays of visual and 

auditory stimuli in relation to EEG recording. The nature of these delays may be different, for 

example, dynamic characteristics of the monitor connected to the “Slave” computer, peculiar 

properties of a particular implementation of any component of the Windows operating system 

and etc. It is difficult to predict the magnitude of these delays in advance, because they depend 

on the specific system configuration. However, these delays can be measured and compensated. 

 

Several steps need to perform to carry out the calibration procedure.  

 

Before start the calibration procedure, make sure that audio playback on "Slave” computer was 

already turned on, and set the maximum volume. 

 

 
 

1. Start PSYTASK using shortcut on Desktop of “Slave” computer if it is not already running. 

 

2. Press “Switch to Slave Mode” button in PSYTASK main window. 

 

3. Start WinEEG using shortcut on Desktop of “Master” computer if it is not already running. 

Here we assume that all the settings described above have already been made. 

 

Important!!! Several additional steps should be performed for old modifications of the 

amplifiers box. This is due to the fact that these amplifiers have no special inputs for Video 

sensor. In this case video and audio synchronization signals are recorded using Bio1, Bio2,… 

channels. To record these signals, you need to prepare an appropriate montage in advance. This 

montage should include corresponding Bio channels. To prepare montage please use the 

command “Setup->Montage List…” from main menu of WinEEG. 

 

If you are new versions of the amplifiers, the preparation of the montage is not required. Special 

channels "VSyn" and “ASyn” will be automatically added to currently used montage. 

 

4. Perform command “File->New” from main menu of WinEEG. The “Patient Card for New 

Investigation” window will appear on the screen. 
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5.  Select appropriate montage if necessary. Skip this step for new versions of the amplifiers. 

 

6. Press “OK” button. А new EEG window will be displayed on the screen. 

 

7. Run command “Recording->EEG Recording” from main menu of WinEEG. 

 

8. Run command “Recording-> Stimuli Presentation Program” from main menu of WinEEG. 

The “Stimuli presentation program list” window (see above) will appear on the screen. 

 

9. Select stimuli presentation protocol with name “AudioVideo 2” and press “OK” button. 

 

10. Make sure that “Slave” computer start the procedure of stimuli presentation. Monitor screens 

should rhythmically change the luminosity with a period of 1 second. 

 

11. Make sure that “Video synchronization signal” (small square) periodically appear (or 

disappear) on the screen. 

 

12. Make sure that the video sensor is located above the display area where the synchronization 

signal appears. 

 

13. Wait until the end of the work of stimuli presentation procedures (approximately 34 

minutes). 

 

14. Stop recording using command “Recording->Stop” from main menu of WinEEG. 
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15. Save the newly recorded data using command “File->Save As…” from main menu of 

WinEEG. 

 

16. Run command “Edit->Adjust trial synchronization” from main menu of WinEEG. The 

“Correct the location of the stimuli in time using the synchronization signals” window will 

appear on the screen. 

 

 
 

17. Pay attention on the shift of visual and auditory stimuli that is which are marked by arrows 1 

and 2 correspondingly. 

 

18. Return to “Slave computer” and press “Esc”. PSYTASK will return to main window. 

 

19. Press “Modify Synchronization Parameters” button. The “Parameters of Synchronization” 

window will appear on the screen. 
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20. Enter corresponding correction of synchronization for visual and auditory stimuli similarly, 

as shown below.  

 

 
 

21. Press “OK” 

 

22. Repeat the steps 1-16 to check the accuracy of the calibration. The results should be 

approximately the same, as shown below. 
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Now, the ERP recording system is not yet ready for ERP recording. 

 

The calibration of the ERP recording system can be performed for visual and auditory stimuli 

separately. The procedure of calibration is very the same excepting that you will use stimuli 

presentation protocols with name “Video 1” and “Audio 1” correspondingly. Each will take 

approximately 17 minutes. 
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How to perform ERP recording 

 

The procedures the ERP recording and the calibration of ERP recording system are similar. But 

they differ in a few steps. This steps will be shown in italics. 

 

1. Place the electrodes on the patient's head. For a normal investigation 19 electrodes are 

placed using the International 10-20 system. Also a "common point" electrode, "N" electrode 

and reference electrodes must be placed.  

 

Attention!!! Common point and reference electrodes are to be placed in any case, whether 

bipolar or monopolar montage is used. If EEG is assumed to be recorded in reference to ears 

two reference electrodes are placed on the ears. A reference electrode can be placed on the 

forehead and connected to A1 or A2 input (the appropriate electrode is provided in the set) and 

a corresponding montage is set in the program. EEG signal quality depends on paying special 

attention to the placement of common point and reference electrodes. 

 

2. Connect the electrodes to their respective inputs on the front panel of the amplifier block. 

 

3. Start PSYTASK using shortcut on Desktop of “Slave” computer if it is not already running. 

 

4. Press “Switch to Slave Mode” button in PSYTASK main window. 

 

5. Start WinEEG using shortcut on Desktop of “Master” computer if it is not already running. 

Here we assume that all the settings described above have already been made. 

 

Important!!! Several additional steps should be performed for old modifications of the 

amplifiers box. This is due to the fact that these amplifiers have no special inputs for Video 

sensor. In this case video and audio synchronization signals are recorded using Bio1, Bio2,… 

channels. To record these signals, you need to prepare an appropriate montage in advance. This 

montage should include corresponding Bio channels. To prepare montage please use the 

command “Setup->Montage List…” from main menu of WinEEG. 

 

If you are new versions of the amplifiers, the preparation of the montage is not required. Special 

channels "VSyn" and “ASyn” will be automatically added to currently used montage. 

 

6. Run the electrode impedance checking mode using command “Recording->Impedance” from 

main menu of WinEEG. If the impedance value is satisfactory (less than 5 kOhm), close the 

Control of Electrode Impedance window. Otherwise re-install those electrode(s) showing 

excessive impedance. 

 

7. Perform command “File->New” from main menu of WinEEG. The “Patient Card for New 

Investigation” window will appear on the screen. 

 



 40 

 
 

8. Select appropriate montage if necessary. Skip this step for new versions of the amplifiers.  

 

9. Fill patient card to identify the EEG recording. 

 

10. Press “OK” button. А new EEG window will be displayed on the screen. 

 

11. Run command “Recording->EEG Monitoring” from main menu of WinEEG. Visually check 

the quality of the live EEG displayed in the new window. If any channel is acquiring EEG 

poorly, re-install the corresponding electrode(s). Check EEG acquisition quality using a 

monopolar montage, without averaging. 

 

12. Run command “Recording->EEG Recording” from main menu of WinEEG. 

 

13. Run command “Recording-> Stimuli Presentation Program” from main menu of WinEEG. 

The “Stimuli presentation program list” window (see above) will appear on the screen. 

 

14. Select appropriate stimuli presentation protocol and press “OK” button. 

 

15. Make sure that “Slave” computer start the procedure of stimuli presentation.  

 

16. Make sure that “Video synchronization signal” (small square) periodically appear (or 

disappear) on the screen. 
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17. Make sure that the video sensor is located above the display area where the synchronization 

signal appears. 

 

18. Wait until the end of the work of stimuli presentation procedures. 

 

19. Stop recording using command “Recording->Stop” from main menu of WinEEG. 

 

20. Save the newly created EEG file into the database using command “File->Save” from main 

menu of WinEEG. 

 

21. Run command “Edit->Adjust trial synchronization” from main menu of WinEEG. The 

“Correct the location of the stimuli in time using the synchronization signals” window will 

appear on the screen. 

 

 
 

22. Press corresponding “Correct” button, if you need to compensate for the random 

synchronization error. The result can be similar as it shown below. 
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23. Press “OK” button. 

 

24. Run command “File->Save” from main menu of WinEEG to save modification. 

 

25. Follow the instructions described in “WinEEG user manual” to compute ERPs and perform 

their analysis. 

 


